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1.0 Introduction 

The Environmental Knowledge Base, or EnvKB, provides architects and engineers 
with a comprehensive and easily accessible source of environmental information, in order 
to help them reduce the environmental impact of facility construction. EnvKB seeks to 
promote sustainability in the use of environmental resources, so that the current 
generation's use of these resources will not jeopardize future generations. 

Purpose 

While interest in protecting the environment has grown in recent years, one of the 
primary factors affecting our nations environment is often ignored - the buildings in which 
we live and work. Environmental impacts are felt throughout the life cycle of a building. 
The manufacture and transportation of building materials result in resource depletion and 
atmospheric and water pollutants. Energy is consumed during a building's use, and 
building occupants may suffer from exposure to construction materials used in the 
building. Also, it is estimated that wastes generated during the construction of a facility 
comprise 25% to 30% of landfill space, second only to paper in many locations. 

Decisions about facility design, building materials, construction planning, and 
operation are currently based primarily on economic and in-place performance. 
Environmental factors such as energy and resource use, toxic by-products, indoor air 
quality, and waste products are often not considered in the current technical, pricing, or 
planning data used as the basis for these decisions. The consideration of environmental 
factors is essential in optimizing standard facility decision processes, obtaining the 
maximum benefits from limited natural and economic resources, and reducing adverse 
environmental impacts. 

Until now, facility designers, builders, and operators have not had a convenient, well- 
grounded means of considering environmental issues during design, construction, and 
building use. While information sources do exist, they are difficult to use in practice 
because they cannot produce tailored recommendations or examples of similar projects. 
EnvKB was developed to meet the need for an environmental knowledge base that 
provides comprehensive, accurate, and relevant environmental information to be used in 
decision processes. 

Description 

Environmental Knowledge Base, or EnvKB, is an interactive software system that 
aids in facility design, construction, and operations. EnvKB was funded by the U.S. Corps 
of Engineers Construction Engineering Research Laboratory (CERL) and the U.S. 
Environmental Protection Agency (EPA). EnvKB uses artificial intelligence technology to 
supplement standard decision-making processes in facility design, construction, and 
operations with current environmental data. 



EnvKB allows the user to enter specific parameters of a design or project, and to 
retrieve information relevant to that design or project in the form of Design 
Considerations and Case Studies. Also, the system has many "browsable" components that 
provide general information about categories such as environmental considerations, 
products, and resources. 

EnvKB is initially free of charge, and a subscription service is available for regular 
updates. Updates will include new case studies and materials evaluations submitted by 
users, as well as updated materials lists. 

Features 

EnvKB provides information about environmental issues related to building design 
and construction with the following features: 

• Information tailored to a user's current project and project design phase 
• Keyword-searchable considerations 
• Consideration Hierarchy Browser 
• Cases Studies of projects with environmentally-friendly design 
• CERL Design Process Map, with text and graphic descriptions of the process of 

facility design 
• Database of Alternative Building Materials, including over 1300 products 
• Interfaces with other software including MC ASES cost estimation, spreadsheets, 

EXPOSURE, and DOE 2.1 
• A tutorial for learning EnvKB which takes about 15 minutes 
• Supporting resources including documents and organizations 

The EnvKB User Guide and Tutorial in the Help pull-down menu (in the Current 
Status window) contain an introduction, the EnvKB system description and procedures, 
and an EnvKB tutorial session. 

Limitations 

It is important to be aware of EnvKB's limitations, which include the following: 

• EnvKB does not replace professional judgment. 
EnvKB does not contain general architectural or engineering principals, and its 
considerations cannot replace the judgment of an expert, particularly with respect to 
performance, aesthetics, safety, code compliance, and cost effectiveness. 

• EnvKB does not perform quantitative analysis. 
EnvKB does not perform the quantitative analysis required to be a true decision- 
making tool. The system still has incomplete backup information for various 
considerations. Auxiliary research, currently in process, may be incorporated into 
future updates of EnvKB to support decision-making processes for cost or benefit 
analysis, potential environmental impacts, and other advantages or limitations. 



2.0 Background 

EnvKB Project History 

• November, 1990 EnvKB SBIR Topic submitted by CERL 
The topic describes the Environmental Knowledge base as a tool to quantitatively 
assess the impact of a facility across its entire life-cycle and the life-cycle of its 
component materials. 

• April 1991, EnvKB SBIR Topic Published by DOD 

• June, 1991, Phase I SBIR proposal submitted to CERL by SHAI 

• October, 1992, 6 month Phase I SBIR begins 

• November, 1992, SHAI acquires ERG and EPA contact 

• December, 1992, CERL and EPA submit joint SERDP proposal 

• March, 1993, End of SBIR Phase I Project - Results: 
Designers require clear, concise information (1 value concept) 
Amount of information on building materials appears to be increasing - ERG 
Phase I Prototype, primarily impact evaluation and presentation 
Phase II to concentrate on impact evaluation 

• June, 1993, Submittal of Phase II SBIR proposal 
Phase II proposal -1 value concept for impact evaluation 
Process qualitative & inaccurate material and impact information 
Contains assumption that rest of SERDP will work concurrently and gather all 
building material information 

• October, 1993 SHAI Phase II SBIR begins, rest of SERDP does not 

• Fall, 1993 Several workshops conceived, scheduled, then canceled. 
SERDP participants almost start work several time 

• May, June, 1994 - New Prototype implemented - mostly cases 

• July, 1994 Santa Cruz meeting of SERDP team - One value concept severely attacked 

• Fall, 1994 EnvKB design and implementation 
Includes greater emphasis on cases and design heuristics 
Several trips to talk to design experts 
Novel Case Based Reasoning / Intelligent Entities representation created for 
considerations 



• January, 1995 SERDP meeting - One value concept laid to rest 
No significant environmental impact information will be available 

• February, 1995 First EnvKB implementation 
Impact evaluation exists with no data 
Primarily considerations and 2 cases 
Case acquisition found to be very difficult 

• April, 1995 Denver Meeting - newer EnvKB demonstrated 
Several suggestions made 
Emphasis shifts from cases to heuristics 

• May, 1995 Design Harmony (DHI) becomes involved in EnvKB for SHAI 

• June, 1995 Trip to CERL - Knowledge Engineering and Demonstrations 

• August, 1995 Montana Building Conference 
EnvKB Booth for demonstrations - Beta Testers signed up 
Bobbi Lippiatt presents paper based on 1 value impact evaluation 

• November, 1995 - North Carolina conference - EnvKB Booth - Beta testers 
Shift in emphasis toward acquiring cases (DHI) 

• November, 1995 - February, 1996 EnvKB Development 
Contract items completed 
Preparation for market 

• March, 1996 North Carolina Meeting 
Near Market version of EnvKB 

• December, 1996 EnvKB Distribution Begins 

Description 

From November, 1990 through October 1993, EnvKB was viewed primarily as a tool 
to evaluate the environmental impact of a building throughout its life-cycle and the life- 
cycles of its component. This required significant information about the building - all of 
its materials and the quantities and the energy, water, maintenance products, replacement 
materials, etc. it would use during its useful life. Additionally environmental impact 
information would be required for each of the items as well as a way to meaningfully 
combine them. The largest concern was in minimizing the entry time for the building 
information. Hence several interfaces to external products were conceived to get this 
information. These included an interface to cost estimators to get materials lists, an 
interface to energy software to get use phase energy requirements, and an interface to 
other project specific lists of materials. An interface to EXPOSURE was also conceived 



to aid the Impact evaluation in relation to IAQ. The availability of this information in an 
extremely accurate form was not assumed. In fact, EnvKB was designed to use extremely 
imprecise and qualitative data on the environmental impacts associated with various 
materials and processes. 

When it became clear that environmental impact information would not be available in 
any form, and the impact evaluation was not viable, the benefit and importance of these 
interfaces decreased dramatically. The only benefit to the information became the 
triggering of relevant advice (or increasing its visibility). 

Additionally, when the ability to evaluate the total environmental impact of a building 
was lost, other parts of EnvKB become much more difficult. Gathering good cases 
became much more difficult, partly because there was no clear way to evaluate them. In 
fact, our user base could have much more easily submitted their projects for inclusion in 
the case base because we could easily confirm that they were good cases. Heuristics 
became much more difficult to gather for the same reason. In fact, some heuristics could 
have been automatically generated from the automatic comparison of the environment 
effects of design changes. In general, EnvKB changed from being quantitative in nature 
and computationally intensive to being very heuristic and knowledge intensive. A change 
which was difficult, uncomfortable, and unpleasant to accept. EnvKB, of necessity then, 
bears little resemblance to the software originally conceived 

Further problems were caused by the SERDP delays. Originally SERDP was to 
supply significant expertise to EnvKB in the form of workshops and experts. (See 
Appendix B). Different workshops were going to focus on different items - user concerns 
for software usability, scientific input for environmental evaluation parameters, design 
heuristics and cases, etc. And most importantly, SERDP was to provide and input the 
impact information on building products. So EnvKB was to rely primarily and very 
heavily on SERDP supplied information, as was clearly described in the Phase II proposal. 
Due primarily to administrative problems beyond the responsibility of any members of the 
SERDP team, no significant information as been received from the SERDP effort. 

A direction we have taken, related to the heuristics, is to be more market driven. DHI 
and our Beta testers have helped us in this respect. Additionally we have incorporated 
comments from our distribution entity - Environmental Building News (EBN). These are 
intended to make the product more marketable. 



3.0 EnvKB Functionality 

In EnvKB, users enter pertinent facts about their projects to customize and focus the 
information presented, showing only what is relevant at a specific design stage of a 
specific project. Then EnvKB offers environmental design suggestions, a database of 
environmental alternative building materials, retrieval of relevant cases of good 
environmental design, integration with spreadsheets, MCACES, and the CERL Design 
Process Map. More detail is given in Appendix A, the EnvKB User Guide. 

Design Suggestions 

EnvKB contains a set of environmental design features, considerations, and 
techniques, many of which are associated with a specific case of good environmental 
design. After the user enters information on a project, each design item is individually 
assessed for its relevancy to that project. The best items are displayed in order of their 
relevancy. The information stored for each design item includes the following: 

• A title in the form of a suggestion 

• A description of the suggestion 

• Directions for incorporating the suggestion 

• Rationale, problems and restrictions associated with the design feature 

• Links to a wide variety of supporting information 

Figure 1 below shows an example of some design suggestions, and Figure 2 shows 
the first suggestion in detail, "Locating floor openings under skylights": 



■jjHJHjiM 

Consideration keyword results: m 
Loealina floor ODeninas under skvliahts 
Locating HVAC system outdoor air intakes on the roof 
Locating living spaces based on solar orientation 
Designing for Boston's particular climate 
Designing to maximize cross ventiiaton in the Summer 
Using gypsum board made with higher percentages of recycled gypsum and recycled cellulose from constr 
Finding out from the wood supplier the source of the wood and ask. about sustainable management 
Including environmental issues when selecting insulation 

' Consideration screening factors" 

Building Systems: Environmental Factors: 

£<] Basic: 

1^1 Intermediate: 

[Zl lAdvanced: I 

?;^T^:?,S*»^<%'J^ i Dopy »e Project sassasBSääwösis iliülll Pari :S>K5-3:-5o:-icc««-K 8 Items 

ÜRIÜRRRRI orated in the project 

Figure 1 



4^ Suggestion jSoimJim a 
Consider: Locating flooi openings under skylights 

Restrictions: Problems: 

Environmental Factors Addressed: 
Energy Use 

Cases: 

Details jHieiarchy;        '    i<( J_j P™* 

Prevalence: Source: 

National Audubon Society HQ 
I Medium 

Audubon House: Building the Enviroi§| 

 Ü 
General Considerations Addressed: 

Maximizing the use and distribution of natural light 

Contradicts: 

Parallel Considerations: 
Using daylight dimming sensors 
Selecting only white to midrange finishes to maximize reflectance of light 
Using skylights, for daylighting 
Devising an open floor plan, to allow esterior daylight to penetrate interior 

Figure 2 

If the user clicked on the "Hierarchy" button in Figure 2, details about the hierarchy 
of principles associated with the general consideration, "Maximizing the use and 
distribution of natural light" would be displayed, as in Figure 3 below: 
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. Principle Hieiarchy 

Moie General Considerations: Parallel Considerations: 
mm 

Maximizing (he use and 
distribution of natural light 

Using skylights, for daylighting 

Using daylight dimming sensors A /     // Current Consideration: 

/      &-.?-. : :- 

Zl 
More Specific Considerations: 

Locating floor openings under 
flights 

\\ ft Parallel Considerations: 

vV '■«• \- Selecting only white to midrange finishes to maximise reflectance of light 

Devising an open floor plan, to allow exterior daylight to penetrate interior 

Figure 3 

If, in Figure 2, the user clicked on the "Details" button, a specific example of 
implementing the suggestion would be displayed, as in Figure 4 below, or perhaps a 
sample of design specification language that can be pasted directly into a building's 
specification: 
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&*. NR DC Floor Plan 

Typical floor plan. Natural Resources Defense Council. 

Figure 4 

An example of specification text retrieved for demolition is shown below, in figure 5. 

02050 DEMOLITION 
02060    BUILDING DEMOLITION 
02 070 SELECTIVE DEMOLITION 

A. The work of this section is to be performed in a 
manner that maximizes salvage and recycling of 
materials and includes the dismantling and 
removal of the materials listed below. 
(Acceptable end uses are indicated in 
parentheses.)  [EDIT TO SUIT PROJECT.]  All 
materials dismantled and removed are to be 
separated, set aside, and prepared for reuse, as 
specified, and stored or delivered to collection 

Figure 5 
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point for reuse, remanufacture, or recycling, as 
specified, and to the maximum extent economically 
■f pa c ] V) 1 f* 

[EDIT TO SUIT PROJECT AND LOCATION.  SEE APPENDIX C - 
DEMOLITION MATERIALS FOR COMPREHENSIVE CHECKLIST.] 
1. Concrete (can be crushed and graded for use as riprap, 

aggregate, sub-base material, or fill). 
2. Brick (can be reused if whole; crushed for use as 

landscape cover, sub-base material, or fill). 
3. Concrete block (can be reused if whole, 

crushed for use as sub-base material or fill). 
4. Land clearing wood (can be chipped or shredded for use 
as ground cover, mulch, compost, pulp, or process fuel). 
5. Whole buildings (can be sold or donated and either 

moved or dismantled). 
6. Asphalt material (can be sorted by type for milling and 

recycling). 
7. Wood (can be sorted by type and size for reuse or 

remanufacturing). 
8. Precast concrete panels (can be used for 

erosion control or landscape features). 
9. Windows and doors (can be salvaged). 
10. Metal (can be separated for recycling). 

Figure 5 (Continued) 
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Alternative Building Materials 

EnvKB includes over 1300 environmentally-friendly building materials to consider. 
These products are also linked to design advice when appropriate. The products are 
indexed by CSI number and can be further sorted by matching keywords. 

Case Retrieval 

EnvKB includes case studies of environmentally good facilities. Environmental 
design experts describe the design features of their buildings and how to apply these 
features in other situations. Each case also includes a list of material choices as well as the 
building's function and location. Cases are presented based upon their similarity to the 
current project. 

MCACES and Spreadsheet Integration 

EnvKB can read MCACES report files to get the list of building components and materials 
and their quantities. EnvKB can also read ASCII files in a format easily exported from 
spread sheets. 

Design Process Map 

CERL has developed a Design Process Map which graphically describes the process of 
facility design, including steps required for good environmental design. EnvKB includes 
an interactive version of this map that users can explore or use to specify a task about 
which to retrieve design suggestions. 

Environmental Networking 

In future releases, we would like to help designers share environmental information and 
expertise. Environmental information discovered by one designer (such as a new product, 
a new recycling outlet, the presence of toxic chemicals in a building product, or innovative 
building designs) can be sent to SHAI and distributed to other EnvKB users in subsequent 
releases. 

14 



4.0 EnvKB Development Process 

4.1 EnvKB Knowledge Representation and Collection Strategy 

Given the current lack of environmental impact information on building materials and 
building related activities, EnvKB has had to concentrate more on qualitative, heuristic 
knowledge used by experts in environmental design. Our primary means of gathering and 
representing knowledge as been through cases of good environmental design. SHAI has 
references to about 100 cases of good design. We have input the 20 most promising cases 
for our current general release. Each case consists of three elements - a description, 
environmental principles applied, and environmental building materials used. 

The case description provides information (such as facility size, location, use, design 
features, etc.) to allow first EnvKB and then the user to determine its relevancy to the 
current project. EnvKB automatically selects the most relevant past cases for the designer 
to review in relation to his own, current project. The format of the description is the same 
as that used to enter project information. 

Associated with each case is a list of the environmental design principles which were 
applied. These principles fall into roughly three categories. Some principles are very 
general, applicable to a very wide range of buildings. In this situation, the case represents 
an example of a particular application of a very general principle. Almost a third of the 
principles fall into this category. Some principles are very specific to the case's situation. 
These principles are only rarely applicable to the current project. The third categories fall 
in between these two extremes. In addition to looking at the principles associated with a 
particular case, all of the principles have been extracted for retrieval outside of the case 
structure. There are almost 300 principles currently in the system (most of which have 
come from the case descriptions). EnvKB automatically searches these principles for the 
most relevant ones and presents them to the user. 

Associated with each case is the list of environmental building materials which were 
used. These supplement the products listed in the National Park Service's green building 
products database. The products are automatically searched by EnvKB to produce a list 
of the ones that are relevant to the current project. There are well over a 1300 building 
products currently listed. 

There are then three main modules within EnvKB, which are linked - Cases, 
Principles, and Products. The primary source of knowledge has been through cases and 
the primary source of case information has been from the designers of those cases. 
Additional knowledge was supplied by design experts at CERL; documents such as 
Environmental Resource Guide, WasteSpec and the Environmental Building News; and 
the National Park Service's database. 

All of the cases and considerations were reviewed by our environmental design 
experts - Design Harmony. Additionally, cases submitted by other designers were sent 
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back to them for their final review. Finally DHI made a final review and modification pass 
of all consideration information. The material information from the National Park Service 
database was not independently reviewed. The material information from the cases was 
reviewed along with the case. 

Sources 

There were several documents used as sources for the information in EnvKB. The 
following documents were used : 

Alliance to Save Energy, 1725 K Street, NW, Suite 509, Washington, DC 20006 

American Solar Energy Society, Inc. 2400 Central Avenue, Suite G-l, Boulder, CO 
80301 

A Primer on Sustainable Building, Barnett, Dianna, with William D. Browning. (Rocky 
Mountain Institute, 1995). 

Audubon House: Building the Environmentally Responsible, Energy Efficient Office, 
published by John Wiley & Sons, Inc., Copyright 1994 by National Audubon Society. 

Center for Maximum Potential Building Systems, Inc. 8604 FM 969 Austin, TX 78724 

Center for Resourceful Building Technology, P.O. Box 100 Missoula, MT 59806 

Daylighting: Performance and Design, Ander, Gregg. (Van Nostrand Reinhold, 1995). 

Design Harmony, Inc., 16 N. Boylan Ave., Raleigh, N.C. 27603 

Design with Climate, Olgay, Victor. (Van Nostrand Reinhold, 1992 edition). 

Draft EPA Report - A guide to indoor air quality considerations during home building and 
remodeling, April 26, 1993. 

Environmental Building News, A Bimonthly Newsletter of Environmentally Sustainable 
Design and Construction, Editor: Alex Wilson, 802-257-7300. 

Environmental Guidelines, British Columbia University, College & Institute Facilities 
ISBN 0-7718-9431-7. 

Environmental Resource Guide, published by the American Institute of Architects, 
October 1993. 

Indoor Air Quality Information Clearing House, U.S. Environmental Protection Agency, 
401 M Street, SW 6202J, Washington, DC 20460 
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Green Home: Planning and Building the Environmentally Advanced House, published by 
Camden House Publishing, Copyright 1993 by Wayne Grady. 

Green Light/Energy Star Buildings Programs, U.S. Environmental Protection Agency, 
P.O. Box 37133, Washington, DC 20013-7133 

Guiding Principles of Sustainable Design, (U.S. Department of the Interior, National Park 
Service, 1993). 

National Parks Service Sustainable Design and Construction Database, National Park 
Service Technical Information Center, PO Box 252871, Denver, CO 80225 

National Renewable Energy Laboratory, U.S. Department of Energy (DOE), 1617 Cole 
Boulevard, Golden, CO 80401 

NIST Technical Report #: NISTIR89-4066. 

NIST Technical Report #: NISTIR4883. 

NIST Technical Report #: NISTIR4634. 

Passive Solar Industries Council, 1511 K Street, NW, Suite 600 Washington, DC 20005 

Regenerative Design for Sustainable Development, Lyle, John Tillman. (John Wiley & 
Sons, 1994) 

Rocky Mountain Institute, 1739 Snowmass Creek Road, Snowmass, CO 81654-9199 

San Francisco Main Library: A Healthy Building, by Anthony Bernheim, American 
Institute of Architects, 59th IFLA Council and Conference, Barcelona, Spain. 1993. 

Site Planning Third Edition, by Kevin Lynch and Gary Hack, MIT Press Cambridge MA 
1984. 

Sustainable Construction: Proceeding of First International Conference of CIB, Kiber, 
Charles J,. ed. (University of Florida Center for Construction and Environment, 1994). 

The American Institute of Architects, Committee on the Environment, 1735 New York 
Avenue, NW, Washington, DC 20006 

Tropical Forest Foundation, 1725 Duke Street, Suite 660, Alexandria, Virginia 22314 

U.S. Green Building Council, 7900 Wisconsin Ave, #400, Bethesda, MD 20814 
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WasteSpec Model Specifications for Construction Waste Reduction, Reuse, and 
Recycling, Triangle J Council of Governments, P.O. Box 12276, Research Triangle Park 
NC 27709, Phone 919-549-0551, July 1995, Prepared by: Judith Kincaid, Triangle J 
Council, Cheryl Walker, Design Harmony Architects, Greg Flynn, AIA, With funding 
from the U.S. EPA, Region IV. 

Knowledge Entry 

An documented feature of EnvKB is that each copy of the software includes methods 
for entering considerations, cases, and alternate building materials. Case and alternate 
material entry is accomplished by using the project entry interface, described in Appendix 
A User Guide. Considerations and principles (higher nodes in the hierarchy) can be 
created or modified by domain experts in the Advice editor. The Advice editor allows 
each field of a consideration to be input as well as its parents in the Principle hierarchy and 
information needed to assess relevancy. This includes types of environmental impacts 
addressed, relevant disciplines, relevant design phases and steps, related cases, 
applicability, indications, counterindications, and relevant building systems. 

4.2 Software Development 

SHAI utilized an incremental development strategy, which allowed frequent changes 
in direction as the project matured. Given the large change in direction which transpired, 
this was an important technique. SHAI used a very strongly object-oriented approach in 
the software development, which facilitates the development of a system which is both 
complex and must evolve considerably over time. 

We chose SmallTalk as the primary knowledge representation and programming 
language. It is probably the most strongly object-oriented of all languages, and its 
interpreted nature gave us considerably flexibility. It proved to be a very good choice for 
consideration and case representation. Further, it possessed excellent user interface 
development facilities, which became important for developing an easy to use, intuitive 
tool, with a large amount of user interface. The primary disadvantage of SmallTalk is 
generally considered its slow speed of execution. This was not anticipated to be a large 
problem since, EnvKB became more heuristic and less computationally intensive. 

The one computationally intensive area of EnvKB is the environmental impact 
evaluation, which was implemented in C++ for rapid execution. We did develop an 
interface from SmallTalk to C++ so EnvKB can call the impact evaluation module. 

4.3 Validation 

EnvKB development proceeded from the Phase I prototype, to a Phase II prototype, 
then through three major releases. At each step, members of the design community 
reviewed the release. Each group that reviewed each release was substantially different 
from the group which reviewed the previous releases, thus ensuring broad review. The 
prototype were reviewed through demonstration. The three major releases were reviewed 
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by sending copies of the software to the designers for use on their own computers. 
Additional review was provided by DHI, our environmental design experts, and EBN, our 
distribution partners. 
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6.0 Marketing/Distribution 

EnvKB Distribution Strategy 

EnvKB is a completely unique tool to help architects and engineers design more 
environmentally friendly buildings. It is a result of gathering environmental design 
techniques, cases, concepts, considerations, principles, methodologies, and products from 
several different sources including case studies, documents, and environmental design 
experts. As such it does not constitute a single philosophy. This dichotomy is consistent 
with the environmental design field itself where several factors interact, synergistically and 
antagonistically and there are several "correct" approaches. It contains information and 
knowledge on a wide breadth of environmental building design topics. The current tool 
emphasizes breadth over depth. These widely divergent nuggets of knowledge have not 
been distilled into a single, organized, consistent philosophy. Rather they have been 
inserted into a facility to allow designers to efficiently and quickly access portions relevant 
to their own current projects and purposes. This facility also helps to emphasize the 
synergistic relationships between related considerations, and allows the designer, should 
he wish, to browse through this relationship network. 

EnvKB is not an automatic design tool. It does not recommend particular courses of 
action. Rather it begs the designer to consider particular environmental issues, design 
techniques which have worked in the past, and related case studies which might provide 
good ideas. It is up to the designer to use good judgment and sound engineering 
calculations to determine whether and how the consideration can be incorporated into the 
design or design process. These considerations are not tailored to the designer's current 
project by changing them. Rather, only the most relevant considerations are retrieved for 
his project and presented in approximately the order of relevancy. This allows substantial 
time savings. To read and digest all of the knowledge and information in EnvKB would 
take several days. Yet within minutes, the designer can get a short list of the most 
relevant considerations for his project. Furthermore, it includes a database of building 
materials and products whose manufacturers reasonably claim to have environmental 
benefits. Finally, EnvKB includes the facility to graphically browse up and down (to more 
general and more specific principles of environmental design) and across (synergistically 
related) principles. This provides a ready environmental design teaching system, to those 
designers or students who want a broad, project-independent overview of the field. 

Because of the emphasis on breadth over depth and on quick application, EnvKB's 
target users are those designers who would like to include environmental aspects in their 
designs but know little or nothing about how to do this. We believe these designers to be 
severely under-serviced by current tools, documents, and periodicals. We also believe 
them to be large in number - in the tens of thousands - and therefore we strongly desire a 
very wide distribution - to make the largest positive environmental impact possible. Our 
typical user is a busy practitioner, with real deadlines, and little or no budget for 
environmental concerns and certainly no time to research or find sources of environmental 
knowledge. We support him by providing the information he needs, on one CD to begin 
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considering environmental issues in his design. Students in a design discipline would also 
find EnvKB quite educational. 

SHAI has several goals for the long-term distribution of EnvKB. First and foremost, 
we would like to pass primary control to an organization with both considerable 
environmental design knowledge and access to and experience with a long-term 
subscription base. EnvKB includes an interface to allow nonprogrammers to input and 
expand the existing knowledge. Little SHAI time or effort would be required to update 
the system, after the organization becomes familiar with it. Secondly, we would like 
EnvKB to become a mechanism for sharing ideas, knowledge, and experience among 
members of the design community. This sharing could include positive and negative 
experiences with products and design techniques, favorable cases of environmental design, 
and new design concepts, techniques, and products. This could be encouraged by a 
reduction or elimination of the subscription cost for significant contributions. Third, we 
would like to see the large majority of subscription funds directed toward product 
improvements, primarily updated knowledge and product information, not toward 
marketing and promotion. Fourth, we would like to see it widely distributed, widely used, 
and incrementally improved both substantially and across several years. We believe that 
the current EnvKB CD is useful for reducing the environmental impact of building designs 
and educating our target users, those short on environmental knowledge but with some 
desire. Yet the product could be substantially improved by environmental design experts 
with little or no programmer assistance, primarily through further environmental design 
research and knowledge entry. We currently visualize a $200 - $250 dollar annual 
subscription price with quarterly updates. 

To facilitate the accomplishment of these objectives, we are pursuing a free 
distribution philosophy of the initial version. We are sending a CD to anyone who sends a 
self-addressed stamped envelope. We decided against an unsolicited mailing, because we 
do want to know there is some effort and therefore some commitment on the part of the 
user to give it an honest try. We would consider distribution of 3000 copies to be 
successful, and definitely beyond anything accomplished to date. We are prepared to 
press as many CDs as are requested. By educating a larger group of designers and 
showing them how they can incorporate environmental considerations without devoting an 
inordinate amount of time, we plan to spawn a market for the paid subscription version. 
There are several organizations that have agreed to help promote the existence of the free 
version or to actually distribute it. These organizations can reach tens of thousands of 
designers, and therefore our target audience. Most importantly their reach extends beyond 
the typical core set of knowledgeable environmental designers, to those with far less 
knowledge. Thus they present an opportunity for the long-term distribution organization 
to greatly expand their base of customers. Each organization is described below, in 
roughly decreasing order of the size of their existing list of potential users. 

The Center for Renewable Energy and Sustainable Technologies (CREST), best 
known as the distributor of the Greening of the White House CD, has agreed to distribute 
the free version of EnvKB. They are currently funded to freely distribute related software, 
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though they do also sell some CDs at a nominal fee (approximately $20). Additionally, 
they have been selected to develop an environmental CD which will be the basis of a 
television show shown nationally on public television in January, 1998. They have said 
that they want EnvKB to be part ofthat CD and television show. 

The NIBS's Construction Criteria Base (CCB) is set of CDs containing several 
documents and software programs of interest to the design community, primarily those 
designers doing work for the Federal government. Their current subscription base is in 
the tens of thousands and their current annual subscription price is over $1000. The have 
agreed to include EnvKB in the next, quarterly release of CCB. 

The Civil Engineering Research Foundation (CERF) has substantial capabilities in 
reaching designers. They have a strong Internet presence and popular Web page, they 
sponsor conferences, have several publications, and man booths. They have agreed to 
aggressively publicize EnvKB. The are handing out EnvKB literature at their conferences 
and their Web page links to ours. 

The AIA has tentatively agreed to promote the distribution of the free release. This 
assistance includes write-ups in their newsletters, publications, software lists, and 
providing SHAI with mailing labels. Their membership numbers in the tens of thousands. 

The Environmental Building News (EBN) is a highly regarded newsletter serving the 
environmental design and construction community. Their newsletter reaches 
approximately 1000 designers. EBN has agreed to be the distribution entity. They fulfill 
most of the desired attributes well. As the paid subscription distributor, it is obviously in 
their best interest to promote the free version as well. They have agreed to review the 
product in their newsletter and provide their mailing list. 

Design Harmony, headed by Gail Lindsey, the chairperson of the AIA's Committee 
on the Environment (COTE), has been intimately involved in the development of EnvKB 
and is a strong supporter. Through the COTE and the regional field committees, Design 
Harmony is able to reach over a thousand interested designers. We anticipate Design 
Harmony's continued involvement throughout EnvKB's life span. 

The Energy Resource Center is an environmental building center in Downey 
California and is included as a case study in EnvKB. They are affiliated with the Southern 
California Gas Company, and they distribute environmental building aids (pamphlets, 
software, etc.) They have added EnvKB to their library. 

Stottler Henke Associates, Inc. (SHAI), developed EnvKB with funding from the 
Construction Engineering Research Laboratory (CERL) of the Corps of Engineers. We 
are distributing the free CD to anyone sending us a self-addressed stamped envelope. In 
addition, we are engaged in mailings, advertising, and attending relevant conferences, as 
well as publicizing it on our Web page. Victoria Schoemer is also planning on doing a 
review in her publication. 
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7.0 Future Work 

The following is the short-term plan for future work, leading up to a paid subscription 
version. The months numbers refer to the months after official Phase II project 
completion. For example if the SBIR is officially closed in February, 1997, Month 1 
would be march, 1997. Further below the medium and long-term plans are also discussed. 

Month 1 

Cases: 
DHI, EBN, and SHAI develop criteria, initial questionnaire, and list of case designers 
to send it to. DHI pursues them. 

Design Concepts (considerations, advice, principles, details, etc.): 
DHI approaches designers (possible COTE executive committee members) until she 
gets 6 to 7 from different areas, willing to contribute 1 to 2 days to review and flesh 
out considerations in their area for a $500 Honorarium plus listing as a source of 
advice. 

Environmental Building Products Database: 
EBN approaches Database Owners. 

Month 2 

Cases: 
DHI, EBN, and SHAI will review case submittals and decide which ones to include. 
DHI, EBN, and SHAI develop follow-on software template. We then send the $100 
Honorarium and software template to accepted case designers. 

Design Concepts: 
We plan to arrange meetings with 6-7 experts and go to some of the meetings. 

Environmental Building Products Database: 
SHAI purchases and EBN acquires the data base. SHAI begins working on the 
interface and EBN begins clean-up. 

Month 3 

Cases: 
Cases will be incorporated. 

Design Concepts: 
We plan to finish meeting the experts and incorporate all of their advice. 
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Environmental Building Products Database: 
Database will be cleaned up and incorporated. 

Finish any additional software changes 

End of Month 3 

We plan to cut the second CD version of EnvKB. It may be free or it may be the first 
subscription version. If it's free, then it will be limited in number. 

Medium Term (After Month 3) 

We plan to incorporate EBN in electronic form, linked to considerations and to 
incorporate EBN material reports. 

Long-Term 

EBN will be licensed to sell subscriptions and update knowledge and information. It 
will retain 80% and SHAI will receive 20% as royalty toward software modifications and 
support. EnvKB will be updated quarterly. NIBS will be approached as an additional 
distribution channel. SHAI will maintain a web page for more frequent updates and 
feedback of information from users (e.g. success/failure of products and techniques). An 
EnvKB user group will be established to offer recommendations on product 
improvements. We will incorporate the results of CERL materials research and future 
EBN issues. 

Future Versions of EnvKB 

EnvKB should become a mechanism for sharing ideas, knowledge, and experience 
among members of the design community. This sharing would include positive and 
negative experiences with products and design techniques, favorable cases of 
environmental design, and new design concepts, techniques, and products. Current plans 
are for substantial contributions which are included in EnvKB to be rewarded by a 
reduction or elimination of the annual subscription price as well as being listed as a source 
for the information. 

Contributions are divided into three categories - cases, consideration-related, and 
product-related. We are especially interested in contributions which are specific to a state 
or region to make EnvKB contain more region specific information. Specification 
language and CAD drawings which can be copied into construction documents are also 
especially helpful. Cases can be submitted in the project format in a saved project file 
(default userfils.obj). Each such project will be reviewed to determine whether it merits 
inclusion. Factors which will be considered are the degree to which the design reduces 
environmental impact, quantitative data available to substantiate this reduced impact such 

24 



as occupancy results or simulation studies, innovativeness of design concepts or use of 
building products, clarity of the description of the implementation methods, and overall 
balance of the EnvKB case base. New considerations or suggested additions to existing 
ones can be submitted using the consider.wri electronic form. New product information 
or comments on existing ones can be submitted by including them in a project and 
submitting the saved projects file. 
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1 About This Product 

Environmental Knowledge Base, or EnvKB, provides architects and engineers with a 
comprehensive and easily accessible source of environmental information, in order to help 
them reduce the environmental impact of facility construction. EnvKB seeks to promote 
sustainability in the use of environmental resources, so that the current generation's use of 
these resources will not jeopardize future generations. 

1.1 Purpose 

While interest in protecting the environment has grown in recent years, one of the primary 
factors affecting our nations environment is often ignored - the buildings in which we live 
and work. Environmental impacts are felt throughout the life cycle of a building. The 
manufacture and transportation of building materials result in resource depletion and 
atmospheric and water pollutants. Energy is consumed during a building's use, and 
building occupants may suffer from exposure to construction materials used in the 
building. Also, it is estimated that wastes generated during the construction of a facility 
comprise 25% to 30% of landfill space, second only to paper in many locations. 
Decisions about facility design, building materials, construction planning, and operation 
are currently based primarily on economic and in-place performance. Environmental 
factors such as energy and resource use, toxic by-products, indoor air quality, and waste 
products are often not considered in the current technical, pricing, or planning data used 
as the basis for these decisions. The consideration of environmental factors is essential in 
optimizing standard facility decision processes, obtaining the maximum benefits from 
limited natural and economic resources, and reducing adverse environmental impacts. 
Until now, facility designers, builders, and operators have not had a convenient, well- 
grounded means of considering environmental issues during design, construction, and 
building use. While information sources do exist, they are difficult to use in practice 
because they cannot produce tailored recommendations or examples of similar projects. 
EnvKB was developed to meet the need for an environmental knowledge base that 
provides comprehensive, accurate, and relevant environmental information to be used in 
decision processes. 

1.2 Description 

Environmental Knowledge Base, or EnvKB, is an interactive software system that aids in 
facility design, construction, and operations. EnvKB is funded by The U.S. Corps of 
Engineers Construction Engineering Research Laboratory (CERL) and the U.S. 
Environmental Protection Agency (EPA). EnvKB uses artificial intelligence technology to 
supplement standard decision-making processes in facility design, construction, and 
operations with current environmental data. 

EnvKB allows the user to enter specific parameters of a design or project, and to retrieve 
information relevant to that design or project in the form of Design Considerations and 
Case Studies. Also, the system has many "browsable" components that provide general 
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information about categories such as environmental considerations, products, and 
resources. 

EnvKB is initially free of charge, and a subscription service is available for regular 
updates. Updates will include new case studies and materials evaluations submitted by 
users, as well as updated materials lists. 

1. 3 Features 

EnvKB provides information about environmental issues related to building design and 
construction with the following features: 

• Keyword-searchable considerations 
• Consideration Hierarchy Browser 
• Cases Studies of projects with environmentally-friendly design 
• CERL Design Process Map, with verbal and graphic descriptions of the process of 

facility design 
• Database of Alternative Building Materials, including over 1300 products 
• Information tailored to a user's current project or project design phase 
• Interfaces with other software including MCASES cost estimation, spreadsheets, 

EXPOSURE, and DOE 2.1 
• Supporting resources including documents and people 

1.4 Limitations 

It is important to be aware of EnvKB's limitations, which include the following: 
• EnvKB does not replace professional judgment. 

EnvKB does not contain general architectural or engineering principals, and its 
considerations cannot replace the judgment of an expert, particularly with respect to 
performance, aesthetics, safety, code compliance, and cost effectiveness. 

• EnvKB does not perform quantitative analysis. 
EnvKB does not perform the quantitative analysis required to be a true decision- 
making tool. The system still has incomplete backup information for various 
considerations. Auxiliary research, currently in process, may be incorporated into 
future updates of EnvKB to support decision-making processes for cost or benefit 
analysis, potential environmental impacts, and other advantages or limitations. 
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2 Before You Begin 

Your EnvKB package should include printed directions for installing and starting EnvKB, 
overview documentation, and a CD containing the EnvKB software. 

2.1 System Requirements 

EnvKB requires a PC running Windows 3.1 or Windows 95, with at least 16 MB of RAM, 
7 MB of free disk space before installation, and a CD drive. 
On Windows 3.1, EnvKB requires the 32-bit modification which is included with the 
package. Install Win32 from the CD. 

2.2 Installation 

Insert the EnvKB CD and run setup.exe. You will be prompted through the installation 
process. 

2.3 Starting EnvKB 

Windows 3.1 
In the Environmental Knowledge Base group, double-click the EnvKB icon, or, from the 
File Manager, double-click the "envkb.exe" file in the directory in which you installed 
EnvKB. Now go to the Tutorial to be guided through a sample session with EnvKB. The 
tutorial can be found in section 3 of the User Guide or in the Help pull-down menu within 
EnvKB, and it is an excellent way to get started or reacquainted with the product. If you 
already feel comfortable with how an EnvKB session works, you might want to see 
section 4 of the User Guide, "Using EnvKB," for detailed functionality descriptions. 

Windows 95 
In the Environmental Knowledge Base group, double-click the EnvKB icon, or run 
"#startme.exe" with the argument "envkb.exe" in the directory to which you installed 
EnvKB. This can be done by creating a shortcut to "#startme.exe" and giving it the 
argument "envkb.exe" in its "Properties" window. Now go to the Tutorial to be guided 
through a sample session with EnvKB. The tutorial can be found in section 3 of the User 
Guide or in the Help pull-down menu within EnvKB, and it is an excellent way to get 
started or reacquainted with the product. If you already feel comfortable with how an 
EnvKB session works, you might want to see section 4 of the User Guide, "Using 
EnvKB," for detailed functionality descriptions. 
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3 Tutorial 

Follow the steps below to walk through a sample session with EnvKB. This sample 
session is a good way to become familiar with EnvKB's many windows and features. 

3.1 Begin 

1. Bring up EnvKB (see section 2.3, Starting EnvKB). You should see a window 
named Current Status. 

2. Choose "Open Projects" under the File menu, and open the file tutorial.obj in the 
EnvKB directory. This file contains two demonstration projects. 

3. You should see a User Name of "John Doe," and a Current Project called "Smith 
Office." If you see a different User Name or Current Project, use the drop down 
box to select the appropriate entry. 

3.2 Predesign the Smith Office Building 

1. Click the "Edit" button next to the Current Project field. 
2. Click the arrow next to the Current Design Development Phase, and select the 

stage Predesign. 
3. Click the "Facility Information" button, and in the Facility Information window, 

choose the "New Development" radio button. 
4. Click the "Climate" button to bring up an interactive map of the United States, and 

click the Chicago area on the map to select a climate zone. 
5. Now click OK to close the map, and OK again to close the Facility Information 

Window. 

3. 3 Retrieve Advice 
1. Back in the Current Status window, click the "Retrieve Design Considerations / 

Case Studies" button. 
2. In the Retrieve Design Considerations / Case Studies window, click the "Design 

Considerations" button to receive considerations relevant to the current project. 
3. In the Consider window, click the box under Environmental Impacts near the 

bottom of the screen, and select Bulk Waste, Resource Depletion, and Toxic 
Waste to limit the list to considerations that impact these factors. 

4. Click OK, then double-click "Reusing existing structure" in the considerations list 
to see more information about that consideration. 

5. In the Consideration window, you can click the "Details" button to see even more 
information, and if the "Switch" button is black, you can switch between several 
different pieces of information. The Details button is very important. You will use 
it more in the course of the tutorial, and you can see section 4.2.1.2, 
"Consideration Window," of this user guide for a description of its functionality. 
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3.4 Renovation 

Now let's try a renovation, as if you had convinced your client to use the consideration 
"Reusing an existing structure." 

1. Close the Consideration, Consideration List, and Retrieve Design Considerations / 
Case Studies windows, and go back to the Smith Office window. 

2. Click the "Facility Information" button, choose the "Renovation" radio button, and 
click OK to close the Facility Information window. 

3. Open the Retrieve Design Considerations / Case Studies window again by clicking 
the "Retrieve Design Considerations / Case Studies" button in the current status 
window. 

4. Click the "Design Considerations" button again, this time to retrieve advice about 
a renovation. 

5. Double-click "Recycling materials from demolition," and click the "Details" 
button. 

6. Click the "Switch" button, and select "Specification Language." This detail gives 
you information that could be copied to the clipboard and pasted directly into your 
specification. 

3.5 Schematic Design 

1. Close all the windows except Current Status and Smith Office. 
2. In the Smith Office window, change the Current Design Development Phase to 

"Schematic Design," and click the "Retrieve Design Considerations / Case 
Studies" button back in the Current Status window. 

3. Click the "Design Considerations" button. 
4. In the Consideration List window, add "Energy Use" to the Environmental Factors 

list and remove "All" from it. 
5. Deselect "Advanced" so that only Basic and Intermediate considerations will be 

displayed. 
6. Double-click the consideration "Placing primarily unoccupied spaces away from 

daylight sources." 
7. Click the "Details" button, click the "Switch" button, and select Audubon Floor 

Plan. This detail shows you a graphic image of a floor plan that incorporates the 
current consideration. The Details button gives you concrete, practical 
information; it could be considered the destination of your search. 

8. Close the Details and Consideration windows. 
9. Back in the list of considerations, double-click "Orienting the office floor plan on 

an east-west axis to maximize daylighting effect" then click the "Hierarchy" button 
to see a graphic representation of the Current Consideration and its relationship to 
other environmental considerations. 

10. Right-clicking the Current Consideration will take you back to the Consideration 
window for the consideration clicked. Right-clicking a Parallel Consideration will 
select that Parallel Consideration as the Current Consideration and re-draw the 
hierarchy to show that consideration's relationship to others. Try right-clicking 
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"Using large exterior windows with high ceilings, for daylighting" and "Devising 
an open floor plan, to allow exterior daylight to penetrate interior" to see how this 
works. See section 4.2.1.2, "Consideration Window," for more information. Note: 
In Windows95, hold the Alt key down while you right-click. 

11. Close the Consideration Hierarchy, close the Consideration window, and notice 
the consideration "Using skylights, for daylighting." 

12. Go back to the Smith Office window and click the "Materials Specification" 
button. 

13. Click the "New" button, type "skylight" in the Material field, type a number in the 
Quantity field, and select the unit "ea" next to the quantity. 

14. Click the OK and "Retrieve Design Considerations / Case Studies" buttons. Notice 
the new consideration, "Locating floor openings under skylight," which came up 
because of the addition of skylights to the materials list. 

15. Close the Consider window, and click the "Retrieve Case Studies" button. 
16. Select "National Audubon Society HQ," and click OK. 
17. Explore the information available from this case. Click the Details button to see 

photos of the building. Close the Details windows and click "Browse 
Considerations" for a list of environmental considerations that were used in the 
case. Click "Materials Specifications" to see how environmentally responsible 
materials were incorporated. 

3.6 Construction Documents 

1. Close all the windows except Current Status again, and change the Current Design 
Development Phase to "Construction Documentation." 

2. Click the "Retrieve Design Considerations / Case Studies" button and then the 
"Design Considerations" button. 

3. Add "Exterior Closure" and "Interior Finishes" to the Relevant Systems field, and 
remove "All." 

4. Click "Design Considerations," double-click the consideration "Including 
environmental issues when selecting insulation," and click the "Details" button. 

5. Click the "Switch" button to see all the details you can choose from. Particularly, 
take a look at details 1 and 2, the Rules of Thumb, the Case Study, and 
Comments. This information is another example of the importance of the Details 
button in retrieving advice. 

6. Now close the Details and Consideration windows, and double-click the 
consideration "Using no or low VOC-emitting paints and stains." Notice that the 
"Materials" button is active. Clicking it will open the Materials database and offer 
product considerations for products related to this consideration, specifically, 
paints and stains. 

7. Click the "Hierarchy" button to browse the Consideration Hierarchy. 
8. Right-click the general consideration "Minimizing the use of fast decay sources," 

and notice the changes as you go up the hierarchy. Note: In Windows95, hold the 
Alt key down while you right-click. 
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9. Right-click the general consideration "Controlling fast decay sources" then 
"Controlling sources," to go up again, and right-click "Volatile organic 
compounds" to go up still further. 

10. Right-click the current consideration, in this case "Volatile organic compounds," 
to go to the consideration window for that consideration. 

11. Click the "Details" button for a definition and other information on VOCs. 
12. Click the "Hierarchy" button to return to the hierarchy at the point from which you 

left. 
13. Double-click the specific consideration "Controlling sinks" to make it become the 

Current Consideration. Notice the changes in the hierarchy. Right-click 
"Controlling sinks" and view the details for a definition of VOC sinks and what 
materials can act as sinks. The Consideration Hierarchy is a powerful browsing 
tool that can teach sound environmental design considerations. 

3.7 Smith House 

1. Close all the open windows except Current Status. 
2. Click the drop down arrow next to Smith Office, and select "Smith House." 
3. Click the "Retrieve Design Considerations / Case Studies button," and change the 

Design Development Stage to "Predesign." 
4. Click the "Design Considerations" button, and add "Resource Depletion" to the 

Environmental Impacts. 
5. Double-click the consideration "Performing site evaluation, design, and land use 

planning from an environmental viewpoint." 
6. In the Consideration window, double-click the parallel consideration "Orienting 

the office floor plan" to see an additional consideration that may be helpful. Notice 
that this consideration replaced "Performing site evaluation" in the Consider field 
near the top of the window. 

7. In the Retrieve Design Considerations / Case Studies window, click the "Retrieve 
Case Studies button," select "Carolina Zen Residence," and click OK. 

8. Click the "Browse Considerations" button to see how this similar project used 
environmental considerations. 

9. Close that window, click the "Materials Specifications" button, and select 
"Nontoxic wood sealers." 

10. Click the "Browse" button, select a Master Format of "09900 Painting," and click 
the "Show" button. 

11. Click the "Reorder by Keywords" button, type "sealer," click the "Add" button, 
and click OK. Notice how easily the extensive materials list was focused on a 
specific product. 

12. Close all the windows except Current Status and Retrieve Design Considerations / 
Case Studies. 

13. Change the Design Development Phase to Schematic Design. 
14. Click "Design Considerations" and add "Energy Use" to the Relevant Impacts 

field. 
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15. Double-click "Orienting the residence floor plan on an east-west axis," and click 
the "Details" button. 

16. Go back out to the Considerations window, and double-click "Locating living 
spaces based on solar orientation." 

17. Double-click the parallel consideration "Improving the building's immediate 
microclimate." This is an example of how a parallel consideration can complement 
the original consideration. Here, solar effects can be augmented by building and 
site considerations. The parallel consideration "Reducing winter wind speed with 
wind brakes" gives more information about the use of wind breaks contributing 
directly to improving the weather's effects on the building. 

18. Go back to the Retrieve Design Considerations / Case Studies window, and 
change the Design Development Phase to Construction Documentation. 

19. Click Design Considerations and change the Environmental Factors field to 
"Recycle." 

20. Double-click "Specifying plastic composite lumber." 
21. Click the "Materials" button, click the "Reorder by Keywords" button, type 

"100%", click "Add," and click OK. Now the Materials Database of plastic lumber 
has been reduced to prioritize entries that contain the text "100%". 

3. 8 Browser 

1. Close all the windows except the Current Status window, and select Browse 
Considerations from the Browser pull-down menu. This feature allows you to 
browse the Consideration Hierarchy starting at the top level, "Being 
environmentally responsible." 

2. Notice that "Conserving Energy" is the Current Consideration; right-click the 
general consideration "Being environmentally responsible" to make it the Current 
Consideration, and notice that "Conserving Energy" is now a More Specific 
Consideration. Note: In Windows95, hold the Alt key down while you right-click. 

3. Double-click any More Specific Consideration to make it the Current 
Consideration. Browsing the Consideration Hierarchy is an excellent way to learn 
considerations of environmentally responsible design. 

3. 9 Exit 

Close all the windows except Current Status. You've completed a comprehensive tutorial, 
and now you should be able to navigate through EnvKB with confidence. You can leave 
EnvKB open if you'd like to use it along with the rest of the User Guide, but if you'd like 
to close EnvKB, choose "Exit" under the File menu. 
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4 Using EnvKB 

EnvKB has many buttons and windows, but there are actually only two things you need to 
do in order to use the product: enter information and retrieve information. You can also 
browse through information without starting a structured search. These tasks are all 
performed from the same starting location, the Current Status window (see Figure 4-A), 
which is the window that comes up when you first launch EnvKB. 

Current Status 

File    Browser    Resources    Help 

Usei Name: John Doe 

Current Project:   Smith Office 

Hi 
PÜ Edit 

RetrieveDesign Considerations / Case Studies 
ii^^*"iww"J'"'- 

Figure 4-A 

4.1 Entering Information 

The information you enter allows EnvKB to give you relevant, helpful advice. The more 
specific you are with your information, the better the information that EnvKB will retrieve. 
There are three kinds of information you can enter: user, project, and design process. 

4.1.1 User Information 

In the Current Status window, you can enter a user name simply by clicking and typing in 
the User Name field, or you can switch users using the drop down list. Click the "Edit" 
button next to that field to access and edit the user type. This information is used to tailor 
the retrieved considerations to a specific profession. 

4.1.2 Project Information 

In the Current Status window, you can enter a new project simply by clicking and typing 
in the Current Project field. Or, you can click the drop down arrow next to that field to 
select from the existing projects. Click the "Edit" button to view and change information 
on this project (see Figure 4.1.2-A). From this project window, click the "Facility 
Information," "Materials Specifications," and "Use Phase Info" buttons to provide detailed 
information. Also, select the Current Design Development Phase from the pop-up menu. 
In the System Breakdown field, you can build a list of systems included in your project by 
using the "Add," "Edit," and "Remove" buttons. These systems provide a means to 
organize your materials specifications, and are useful for browsing case studies. 
The materials specification window lets you add information about the materials in your 
project. Some materials that impact the consideration retrieval process are available in a 
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drop down list, but you can also add new material types and fill in information about the 
their performance. Filling in materials performance information and sending SHAI the 
project files will allow SHAI to incorporate that information and distribute it in future 
EnvKB releases. 

Smith Office 

Name:    Smith Office 

lw-,-'^ww 
«^««M^^W««-«« Aw^ww^y^^w-^w^w. 

^■ftJWWWJ.MWvuw~w. JL-ä-äW<^^W.V.-MW.W «i«wivi'h-Wh.wMwsi»^'8l 

Current Design Process Step: 

Current Design Development Phase: 

Predesign Hi 

System Breakdown: 

Figure 4.1.2-A 

4.1.3 Design Process Information 

In the Project Information window (Figure 4.1.2-A), you can specify the project's current 
design task in the Current Design Process Step field. Clicking the "Select" button will 
bring up the Design Process Map, where you can select your project's current step; right- 
click to open stages, and left-click to highlight your selection. Entering this information 
allows EnvKB to focus its search and provide pertinent advice. Note: In Windows95, 
hold the Alt key down while you right-click. 

4.2 Retrieving Information 

Retrieving helpful information is the main objective of EnvKB, and there are several ways 
you can access this information. You can retrieve relevant Design Considerations, similar 
Case Studies, and Alternate Materials. 

4.2.1 Design Considerations 

Design Considerations are an important part of EnvKB. Everything you've done up to this 
point with the product has been for the purpose of retrieving these considerations and the 
information associated with them. This information is used to build tailored lists of 
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considerations, in decreasing order of relevance to the current project. You can also 
search the considerations from the Consideration List window with keywords, and you 
can view them through their hierarchy connections in the Current Status window's 
"Browse Considerations" menu item. 

4.2.1.1 Retrieval Window 

Figure 4.2.1.1-A below shows the Retrieve Design Considerations / Case Studies window, 
which is brought up from the Current Status window by clicking the "Retrieve Design 
Considerations / Case Studies" button. This window is the starting point for information 
retrieval. Before you actually retrieve information, verify your project information in this 
window, and edit it if necessary. Remember, the more detailed the information you 
provide, the more focused the information you retrieve will be. 

SRetrieve Design Considerations / Case Studies 

Local Copy Targe» Values for Retrieval - Smith Office" 

DPM Step: 

Urban Level: 

Primary Comp: 

Zone Type: 

User Type: 

Temperatures: 

Total Floor Area: 

tt of Floors: 

Urban m 
Steel 

Office 

Architect 

Full summer / Cold winter 

10000 fP 

Design Dev Phase:   Predesign mi Hum 
Renovation: ^ 

Figure 4.2.1.1-A 
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4.2.1.2 Consideration Window 

Clicking the Design Considerations button at the bottom of the Retrieve Design 
Considerations / Case Studies window (see Figure 4.2.1.1-A) brings up a list of relevant 
considerations in a Consideration List window. See figure 4.2.1.2-A below. 

In order of relevancy consider: Ltfgk&jttixi. 

Reusino existina structure 
Specifying that contractors separate, and reuse or recycle glass building products 
Designing ID maximize cross ventilaton in the Summer 
Employing a task/ambient approach with greatly reduced level of ambient light 
Designing for energy efficient lighting systems 

'Consideration screening factors" 

Building Systems: Environmental Factors: 

HVAC 
Electrical 

ALL m Basic: 

S Intermediate: 

O Advanced: 

itih'ril'ftaWi>aaa&aaM 

5 Items 

Figure 4.2.1.2-A 

Add any relevant Building Systems or Environmental Factors to the fields at the bottom of 
the window by clicking the fields and choosing from their pop-up lists. These fields filter 
the advice to only address the selected systems or impacts. 

The three check boxes on the right allow the user to view considerations at the specified 
level of sophistication. Basic considerations should almost always be incorporated, since 
they have little or no disadvantage in terms of cost or environment. Intermediate 
considerations may require some additional cost or calculations, and they may have a 
payback period or adverse environmental effects. Advanced considerations require 
calculations to evaluate cost and environmental trade-offs. 

The following buttons are available at the bottom of the screen: 
•   "Remove from Project" removes the selected Consideration from your current 

project. 
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'Copy to Project" copies the selected Consideration to your current project. 
'Rationale" offers the justification for the use of the Consideration in a project or 
case. 

• "Search" allows the user to enter keywords which are used to search the entire set 
of considerations. 

• "Print" prints the Consideration list currently displayed. 
• "Explanation" offers an explanation of why the consideration was retrieved. 

Each of the considerations can be double-clicked for even more information. Double- 
clicking a consideration brings up its Consideration window, where you can find 
comprehensive information about that consideration. A keyword search of considerations 
can also be started in this window. See figure 4.2.1.2-B below. 

Consideration 

Consider: 
Orienting the office floor plan on an east-west axis, to maximize daylighting effect 

Problems: 
U 

Restrictions: 
Solar heat gain in the Summer, however, 
the Audubon Headquarters solved this 
problem through window selection 

Environmental Factors Addressed: 

Cases: Prevalence: 

National Audubon Society HQ High 

Hierarchy 

Source: 

^*********™~*m******** 

_.       Level: 

General Considerations: 
Intermediate 

Audubon House: Building the Enviro|| 

Organizing the floor plan to maximize the use of natural light 
Designing to maximize heat gain in the winter 

Contradicts: 
Designing to minimize heat gain in the summer 

Parallel Considerations: 
roSSjiiigejBxtenoo^   
[Selecting onlp white to rnidrange finishes to maximize reflectance of light 
Using smaller partitions near the exterior 
Using superwindows (super efficient} 

Figure 4.2.1.2-B 

This Consideration window gives you information in the following fields: 
• The Restrictions field has information about situations where the consideration 

cannot be used. 
• The Problems field alerts you to some of the drawbacks in implementing the 

consideration, as well as some possible solutions to these drawbacks. 
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• The Environmental Factors Addressed field identifies the environmental issues 
associated with the consideration. 

• The Cases field shows cases in which the consideration has already been used. 
Double-clicking a related case will open its project information window and let 
you access its details. 

• The Prevalence field gives you an idea of how commonly the consideration is 
actually implemented. 

• The Level field indicates the level of sophistication associated with the 
consideration, basic, intermediate, or advanced. See the description of Figure 
4.2.1.2-A above for more information. 

• The Source field contains the reference material from which the consideration 
came. Double-clicking a Source entry will access that bibliographic information so 
you can use it to research the consideration in greater depth. 

• The General Considerations field lists the general considerations addressed by this 
particular consideration. Double-clicking a General Consideration will initiate a 
browse of the advice hierarchy starting with that consideration. 

• Contradicts are considerations that the current consideration contradicts. Double- 
clicking a consideration in the Contradict field will bring up the same level of 
information about that entry as is shown for the current consideration; whatever 
Contradict you select will replace the current consideration in the display. 

• Parallel Considerations are other considerations that tend to increase the effect of 
the consideration synergistically. Double-clicking a consideration in the Parallel 
Considerations field will bring up the same level of information about that entry as 
is shown for the current consideration; whatever Parallel Consideration you select 
will simply replace the current consideration in the display. 

Clicking the "Details" button can give you access to the information which you began 
searching for in the first place. If the "Switch" button is black in the Details window, you 
can switch between several specific details. These details could include clarification, 
examples of successful implementations, rationale, importance, schematics or other helpful 
graphic images, directions for implementing conceptual considerations, and specification 
language which can be copied and pasted into your own specifications. Don't forget to 
explore all the details available for any of your relevant considerations. 

The "Hierarchy" button lets you browse the advice hierarchy starting with the current 
consideration. Right-click a general consideration to make it the Current Consideration. 
Double-click any More Specific Consideration to make it the Current Consideration. 
Browsing the Consideration Hierarchy is an excellent way to learn considerations of 
environmentally responsible design. Note: In Windows95, hold the Alt key down while 
you right-click. 

The "Materials" button cross-references you to the Alternate Materials database, where 
you can browse or retrieve specific information. 
The "Print" button prints the information presented in the Consideration window and the 
details accessed by the "Details" button. 
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4.2.2 Alternate Materials 

You can get information about alternate materials to use from any project window, either 
your own or a case study's. Clicking the "Materials Specifications" button brings up a 
Materials Specifications window, where you can click either the "New" button or the 
"Browse" button to access the list of Alternates. Selecting a Master Format number lets 
you narrow your materials search. Click the "Show" button to see the actual list. If you 
like, you can reorder the list at this point based on one or more keywords. Just click the 
"Reorder by Keywords" button and enter your keywords. 

4.2.3 Similar Case Studies 

Clicking the "Retrieve Case Studies" button at the bottom of the Retrieve Design 
Considerations / Case Studies window (see Figure 4.2.1.1-A) brings up a list of cases 
similar to your own. Viewing these cases can help you see how others have addressed 
problems like yours, and give you ideas for your own solutions. You can view a case by 
selecting it and clicking OK. The Case window that comes up has four key buttons that let 
you compare your case to the retrieved case: 

• "Details" has images and information about the current case. 
• "Facility Information" provides information about the case's context. 
• "Facility Materials Specifications" lets you see the materials that were used. 
• "Browse Considerations" gives you a list of the environmental considerations that 

were considered and implemented. 

The case studies list is in descending order of relevance to the current project. 

4.3 Pull-Down Menus 

Using the pull-down menus from the Current Status window (see Figure 4-A) allows you 
to browse through information without starting a structured search. You can find helpful 
information this way, but remember, if you are trying to find specific solutions for a 
particular case, you'll be much more successful by opening a project, entering detailed 
information, and retrieving advice based upon that information. 

4.3.1 Help 

From the Help menu, select "User Guide" to access an on-line version of the EnvKB User 
Guide. Print this document, or just browse through it on-line. Or, from the Help menu, 
select "Tutorial" for an on-line version of the tutorial found in section 3 of the User Guide. 
Again, print this document, or just use its electronic form. 
The "Report Comments" selection opens a text document with SHAI's contact 
information. You can use this to send us your feedback via fax, e-mail, or the postal 
service. We welcome your comments, bug reports, and enhancement considerations. 
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Select "Print" from the File menu to fax or mail us your comments, or save your 
comments as a text file to e-mail. Select "Exit" from the File pull-down menu to close the 
file. 

4.3.2 File 

From the file menu, you can choose to load a project file, save a project file, or exit the 
system. A project file can contain many users and many projects. 

4.3.3 Browser 

From the Browser menu, select "Browse Considerations" to access the Consideration 
Hierarchy window. This browser allows you to explore the hierarchy of considerations 
available within EnvKB, which is effective on its own as a tutor of environmental design 
knowledge. Select Exit from the File pull-down menu to close the browser. 

Select "Browse Case Studies" to access the complete list of case studies. Double-click a a 
case study to open it. 

Select "Browse Materials" to examine the environmental materials database without going 
through a materials list for a specific project. 

Select "Browse Chemicals" to access a list of federally regulated chemicals commonly 
found in building materials. This list is useful in interpreting MDSD and other product 
make up information. 

Select "Browse Glossary" to view a list of words used in EnvKB. Click a term to see its 
definition, and select Exit from the File pull-down menu to close the Glossary. You can 
use this tool anytime, even during a search. 

4.3.4 Resources 

This menu allows users to access contact information about environmental information 
sources. The sources include documents, organizations, and cases, and can be chosen by 
the type of environmental impact addressed. 

4.3.5 Updates 

This menu informs users about the process for receiving regular updates to EnvKB with 
updated and expanded information. 
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5 Frequently Asked Questions 

How much information about my project must I enter to get relevant advice? 
The more detailed the information you provide, the more relevant the information you 
retrieve will be. However, EnvKB can still be a productive tool with very little user- 
specified information. As a minimum, you must enter a user Discipline and a project 
Current Design Development Phase. 

How can I access the database of friendly materials? 
In any project window, your own or a case study's, click the "Facility Materials 
Specifications" button, and then click either the "New" or the "Browse" button. Focus 
your search by specifying a Master Format and one or more keywords. See section 
4.2.1.1, Alternate Materials, or Step 6 of the Tutorial for an example. 

How can I incorporate advice into my construction specifications? 
Any advice that teaches you something new will help you develop more environmentally 
responsible plans and specifications simply by enhancing your expertise, but EnvKB does 
allow you to cut and paste some Specification Language from Design Considerations 
details. You can find an example of this in Step 4 of the Tutorial. 

How can I retrieve information about a project similar to my own? 
From the Retrieve Design Considerations / Case Studies window, click "Retrieve Case 
Studies," select a case, and click OK. See section 4.2.2, Similar Case Studies, for more 
information. 

Can I submit my own project as a case? 
Projects can be submitted for inclusion as cases in the next release of EnvKB. Each such 
project will be reviewed to determine whether it merits inclusion. Factors which will be 
considered are the degree to which the design reduces environmental impact, quantitative 
data available to substantiate this reduced impact such as occupancy results or simulation 
studies, innovativeness of design concepts or use of building products, clarity of the 
description of the implementation methods, and overall balance of the EnvKB case base. 
Make sure your project information is complete and includes Details (from the "Details" 
button in the Project window) and Rationale information (from the "Rationale" button in 
the Project Considerations window), then click the "Save as Case" button in the Project 
window. This will created a file named "userfils.obj" in EnvKB's base directory, which 
you can access from then on. After entering a project, exit the system and mail or e-mail 
the "userfils.obj" file to SHAI. 

What is the Architectural Design Process flowchart for? 
The Architectural Design Process flowchart is accessed by clicking the "Select" button 
next to the Current Design Process Step in the project window, and it allows you to 
specify your project's current step. To select a step in the process, right-click to open 
stages, and left-click to highlight your selection. Some advice can only be retrieved if this 
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information has been entered. See section 4.1.3, Design Process Information, for more 
details. Note: In Windows95, hold the Alt key down while you right-click. 

Who can I contact with questions, suggestions, or problems? 
Send your comments to SHAI via the "Report Comments" selection under the Help menu. 
See section 4.3.1, "Help," for details. 
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Appendix B 
EPA's role in EnvKB project, 10/4/93 

The following paragraphs detail the EPA's role in the environmental knowledge base 
project. Some tasks will be performed by EPA-funded contractors, some by EPA 
personnel, and some by organizations that the EPA contacts but does not need to fund. 

1. Materials Research and Entry 

An EPA sponsored contractor will research the environmental impacts of building 
materials and components throughout the materials life-cycle and enter the information 
into the Environmental Knowledge Base using entry software developed by SHAI. This 
entry shall be under the guidance of SHAI. 

The accuracy, level of detail, and required quality of information will vary with each 
material or component. In many cases gross approximations will be used to minimize the 
research costs per material or component. The gross approximations will often take the 
form of qualitative information. For materials making the largest environmental impact, 
more accurate analysis will be performed. These will be materials that are used in vast 
quantities in buildings or materials which have large impacts associated with them. The 
EPA should participate in deciding which materials should be researched first and to what 
level of detail. This research should begin as soon as possible. 

2. Green Design Expertise 

The EPA will supply the expertise on designing environmentally friendly buildings. 
This will often come from architects and engineers who specialize in design of 
environmentally friendly buildings. This expertise should start to be available as soon as 
possible. 

3. Green Operations Expertise 

The EPA will supply the expertise on operating buildings in an environmentally 
friendly way. This will often come from building operators who pride themselves in 
environmentally friendly building operation, suppliers of environmentally friendly 
maintenance products, and specialists in the building operations industry. Operations 
expertise relating to design, such as environmentally friendly operations which require 
consideration during the design process, should be available as soon as possible. Most of 
the operations expertise will be required starting July 1, 1994 

4. Green Construction Expertise 

The EPA will supply the expertise on environmentally friendly construction methods. 
This will come from builders, architects, and engineers who are considered 
environmentally oriented. Expertise on construction methods which must be considered 
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during the design stage should be available starting as soon as possible. Other 
construction expertise needs to be available starting December 1, 1994. 

5. Environmental Information 

As the federal agency responsible for protecting the environment, the EPA has an 
enormous amount of data relating to the environment. This needs to be made available so 
that SHAI and the materials research contractor can ascertain what information is useful. 
This data needs to be available January 1, 1994. 

6. Promotion / Distribution - (Green Lights) 

The EPA is in a position to recruit users of the environmental knowledge bases, much 
as they currently do for the Green Lights program. The environmental knowledge base 
can be promoted without significant cost by using the existing green lights recruitment 
programs. These include conferences, a full-time traveling sales campaign consisting of 
direct visits, telemarketing, advertising, and news coverage. The first commercial version 
of the software is scheduled for completion October 1, 1994. 

7. Indoor Air Quality Model 

The EPA is supplying the indoor air quality and occupant exposure model. The 
model will be included in the environmental impact assessment. The model should be 
available July 1, 1994. 

8. Operational Users 

The EPA will contact federal operators of facilities for their input as potential users of 
the environmental knowledge base for building operators. Building operator user input is 
required after July 1, 1994 

9. Trade-offs, Policy Decisions 

10. Impact Assessment Guidance 

To aid acceptance by environmental scientists, help decide among alternatives. 
Help Acquire Environmental Endorsements including evaluation of software 

Handle complaints of suppliers? 
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